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Introduction
Welcome to TX Text Control, the text processor in a single ActiveX
control. Using Text Control, you can create all kinds of text-based
applications with the ease of programming that is characteristic of
Visual Basic and with highly sophisticated formatting and display
capabilities which are normally the exlusive domain of large word
processing packages.

System Requirements
The Text Control ActiveX control requires the following minimum
configuration:

w Windows 95 or Windows NT 4.0.

w Microsoft Visual Basic or any development platform which supports
ActiveX controls.

Distributing your Applications
The table below shows all the files necessary for Text Control to
operate properly. You must ensure that these files exist on your client's
machine and they are the correct version. If your client's machine has
older versions of these files, you should update them.
_____________________
1 TX4OLE.OCX
_____________________
2 TX32.DLL

TXTLS32.DLL
WNDTLS32.DLL
TXOBJ32.DLL
IC32.DLL
IC32.INI
TX_BMP32.FLT
TX_TIF32.FLT
TX_WMF32.FLT
TX_RTF32.DLL
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TX_HTM32.DLL
TX_WORD.DLL

_____________________
3 MFC40.DLL

MSVCRT40.DLL
_____________________
4 TX_GIF32.FLT

The first file (group 1) is the Text Control ActiveX server containing
the ActiveX controls. These controls must be registered in the
registration database on your client's machine.

The files listed in the second group are the additional Text Control DLL
files. They must be installed in the same directory as the ActiveX
server. You must always install all of them.

You should also verify that the Microsoft foundation class library files
(group 3) are installed on your client's computer. These files must be
installed in the Windows system directory. Please refer to Microsoft's
redistribution policy if you need to redistribute them.

The last file (group 4) is a filter to use the GIF image format with Text
Control. Unisys Corporation holds patent rights to the LZW technology
used in this filter. If a customer wants to use the GIF file format, he is
required to obtain a license from Unisys and send a copy of the license
agreement to The Imaging Source Europe GmbH. We will then send
him the GIF filter free of charge.

Getting Started
Now that you have TX Text Control, the first thing you will want to do
is to install it onto your system. To perform the installation, simply
insert the Text Control CD into your CD ROM drive and run the
Setup.exe program. If you have downloaded the Text Control
installation file from the Text Control web site, simply run the self-
extracting installation file.
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Once the installation is complete, the quickest way to get an overview of
what you can do with TX Text Control is to look at the sample
programs. The most comprehensive sample included with Text Control,
is the TX Text Control Words demo program, that can either be started
directly from the last dialog of the setup program or through an item in
the Text Control program folder.

TX Text Control Words illustrates many of the features in TX Text
Control, but it only begins to demonstrate the full creative potential
available with TX. Because of TX Text Control’s scalable design, you
do not have to stick to standard word processing style user interfaces.
You can design the user interface that is right for your application and
you can pick and choose from the appropriate controls included with
Text Control.

The remainder of this book is devoted to creating a simple word
processor with TX Text Control. It contains examples for Visual Basic,
Delphi, and Visual C++.
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A Simple Word Processor in Visual Basic
This chapter shows you how to create a small word processor from
scratch with just a few lines of code. It will be able to load and save
files, use the clipboard, and will have dialog boxes for character and
paragraph formatting, a ruler, a status bar and full keyboard and mouse
interface. The source code for this example is contained in the Simple
sample source directory.

Creating the Project
Assuming that you have already run the Text Control installation
program and started Visual Basic, the next step is to create a project for
the text processor. To do this begin by selecting the New Project
command from the file menu. Then use the Tools / Custom Controls...
command to include the file 'tx4ole.ocx' into the new project. You will
see four additional icons appear at the bottom of the toolbox,
representing the Text Control and its Status Bar, Button Bar and Ruler:

The Text Control Icon The Status Bar Icon

The Button Bar Icon The Ruler Icon

Creating the Controls
The next step is to put these four
controls onto a form and connect them.
Click on the Text Control icon and
draw it on the form. In the same way,
create a Ruler and a Button Bar on top
of the Text Control, and a Status Bar
below it. Your form should now look
like the diagram on the right:

Connecting the Controls
Add the following code to the form's Load event procedure:
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Private Sub Form_Load()
    TXTextControl1.ButtonBarHandle = TXButtonBar1.hWnd
    TXTextControl1.RulerHandle = TXRuler1.hWnd
    TXTextControl1.StatusBarHandle = TXStatusBar1.hWnd
End Sub

Running the Program
The text processor is not yet finished, but we can make a first attempt at
running it to see what it can do. Click the 'Start' button. You can type in
some text, select it with the mouse, copy it to the clipboard (use the
<CTRL>+<C> and <CTRL>+<V> keys as long as there is no menu),
select a different font, set tabs and do lots of other things. All of these
features have been built into the Text Control
and can be used with almost no programming
effort.

You will have noticed, however, that some
features are still missing. For instance, if you
resize the main window, the controls keep
their old sizes. There is no menu, and there
are no scrollbars either. We will fix this in
the coming chapters.

Adding Scrollbars
To add scrollbars, click on the Text Control
window to have its property list displayed.
Click on the Scrollbars property and select
3 - Both. Select the PageWidth property and
enter 12000, which is about  the width of a
letter in twips, the currently selected
measurement. Set PageHeight to 15000 for
now.
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Resizing the Controls
Two steps are involved in making the controls resize properly when the
main window is resized.

w Set the Align property to 1 - Align Top for the Button Bar, the Ruler and
the Text Control. Set it to 2 - Align Bottom for the Status Bar. This will
adjust everything except the height of the Text Control.

w Open the code window for the form which contains the Text Control. In
the combo boxes on top of the code window, select 'Form' in the
'Object:' box and 'Resize' in the 'Proc:' box. The code window should
show an empty procedure for the Resize event:

Private Sub Form_Resize ()
End Sub

Extend it as follows:

Private Sub Form_Resize ()
    TXTextControl1.Height = ScaleHeight - TXRuler1.Height _
    - TXStatusBar1.Height - TXButtonBar1.Height
End Sub

This line of code will cause the Text Control's height to be adjusted
every time the size of the form is altered. (The ' _' character is used to
extend one logical line of code to two or more physical lines).

Adding a Menu
In this section, you will add a
menu to the text processor to
enable you to call the Text
Control's built-in dialog
boxes.

Use the Visual Basic Menu
Editor to create a Format
menu with the items
Character... and Para-
graph....
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Name the items 'mnuFomat_Character' and 'mnuFormat_Paragraph'.
(Please refer to the Visual Basic documentation if you need help with
creating menus).

Add the following code to the Click procedures of the menu items:

Private Sub mnuFormat_Character_Click()
TXTextControl1.FontDialog

End Sub

Private Sub mnuFormat_Paragraph_Click()
TXTextControl1.ParagraphDialog

End Sub

Start the program again. You should be able to use
the menu items to call the Font and Paragraph
dialog boxes.

Now for the Edit menu. Again use the Menu
Design Window and create an Edit menu
containing items for Cut, Copy, and Paste. The
code for these menu items is:

Private Sub mnuEdit_Cut_Click()
TXTextControl1.Clip 1

End Sub

Private Sub mnuEdit_Copy_Click()
TXTextControl1.Clip 2

End Sub

Private Sub mnuEdit_Paste_Click()
TXTextControl1.Clip 3

End Sub

Having added these menu items, you can exchange
formatted text with other word processors via the
clipboard.

Finally, we shall add one last menu. Create a File
menu including the items Load... and Save As.... Place a common dialog
box icon on the form and enter the following code, which will call the
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common dialog box to get a file name from the user, and will then load
respectively save the selected file:

Private Sub mnuFile_Load_Click()
On Error Resume Next

' Create an "Open File" dialog box
CommonDialog1.Filter = "TX Demo (*.tx)|*.tx"
CommonDialog1.DialogTitle = "Open"
CommonDialog1.Flags = cdlOFNFileMustExist Or _

cdlOFNHideReadOnly
CommonDialog1.CancelError = True
CommonDialog1.ShowOpen
If Err Then Exit Sub

' Pass the filename to the text control
TXTextControl1.Load CommonDialog1.filename, 0

End Sub

Private Sub mnuFile_SaveAs_Click()
On Error Resume Next

' Create a "Save File" dialog box
CommonDialog1.Filter = "TX Demo (*.tx)|*.tx"
CommonDialog1.DialogTitle = "Save As"
CommonDialog1.Flags = cdlOFNOverwritePrompt Or _

cdlOFNHideReadOnly
CommonDialog1.CancelError = True
CommonDialog1.ShowSave
If Err Then Exit Sub

' Open the selected file
TXTextControl1.Save CommonDialog1.filename, 0

End Sub
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A Simple Word Processor in Delphi
This chapter shows you how to create a small word processor from
scratch with just a few lines of code. It will be able to load and save
files, use the clipboard, and will have dialog boxes for character and
paragraph formatting, a ruler, a status bar and full keyboard and mouse
interface.

The source code for this example is contained in the Delphi20 sample
source directory.

Loading the Text Control OCX into Delphi
After installing the Text Control package, you can add the Text Control
into the ´OCX´  page on Delphi´s component palette.

1. Select ´Install´  from the ´Component´  menu.

2. In the ´Install Components´  dialog box, click on the ´OCX´  button to
bring up the ´Install OCX´  dialog box.

3. Select 'DBS GmbH - TX Text Control' in the Registered Controls
listbox.
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4. Click ´Ok´  to return to the ´Install Components’ dialog box.

5. Click ´Ok´. Delphi will add icons for the 4 controls to the component
palette. You are now ready use Text Control in your applications.

Creating the Controls
The next step is to put these four controls on a form and connect them.
Run Delphi and create a new project. Select the ´OCX´  page in the
component palette to have the 4 Text Control icons displayed. Click on
the Text Control icon and draw it on the form. In the same way, create a
Ruler and a Button Bar on top of the Text Control, and a Status Bar
below it. Your form should now look like this:
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Connecting the Controls
Double-Click on the form to bring up the code template for the
FormCreate event and enter the following code:
procedure TForm1.FormCreate(Sender: TObject);
begin

TextControl1.ButtonBarHandle := ButtonBarControl1.Handle;
TextControl1.RulerHandle := RulerControl1.Handle;
TextControl1.StatusBarHandle := StatusBarControl1.Handle;

end;

Running the Program
The text processor is not yet finished, but we can make a first attempt at
running it and seeing what it can do. Click the Start button. You can
type in some text, select it with the mouse, copy it to the clipboard (use
the <CTRL>+<INS> keys as long as there is no menu), select a diffe-
rent font, set tabs and do lots of other things. All of these features have
been built into the Text Control and can be used with almost no
programming effort.

You will have noticed, however, that some features are still missing. For
instance, if you resize the main window, the controls keep their old
sizes. There is no menu, and there are no scrollbars either. We will fix
this in the coming chapters.

Adding Scrollbars
To add Scroll Bars, click on the Text Control window to have its
property list displayed. Click on the Scrollbars property and enter 3.
Select the PageWidth property and enter 12000, which is about  the
width of a letter in twips, the currently selected measurement. Set
PageHeight to 15000 for now.

Resizing the Controls
The 4 controls still have the size and position which they initially had
when you created them, reagrdless of the window size. To change this,
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switch the form´ s AutoScroll property to False and add the following
code to the FormResize procedure:

procedure TForm1.FormResize(Sender: TObject);
begin

ButtonBarControl1.Width := ClientWidth;
RulerControl1.Width := ClientWidth;
StatusBarControl1.Top := ClientHeight

- StatusBarControl1.Height;
TextControl1.Width := ClientWidth;
StatusBarControl1.Width := ClientWidth;
TextControl1.Height := ClientHeight

- ButtonBarControl1.Height
- RulerControl1.Height
- StatusBarControl1.Height;

end;

Adding a Menu
In this chapter, you will add a menu to the
text processor to enable you to call the Text
Control’s built-in dialog boxes.

Drop a TMainMenu component onto the
form and add the items ‘&File’, ‘&Edit’ and
‘F&ormat’ to the menu bar.

Add the following items to the File menu:
‘&Open...’, ‘&Save’, ‘Save &As...’, ‘-’,
‘&Print...’, ‘-’ and ‘E&xit’.

Add the following items to the Edit menu:
‘Cu&t...’, ‘&Copy’, and ‘&Paste’.

Add the items ‘&Character...’ and ‘&Para-
graph...’ to the Edit menu.

Declaring Constants

Add the following constant declarations for
Text Control’s Clip property:
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const
CLIP_CUT = 1;
CLIP_COPY = 2;
CLIP_PASTE = 3;
CLIP_CLEAR = 4;

Additionaly, declare two constants to determine the file type contained
in the word processor, one for the filename extensions, and one for the
name of a newly created document:

const
RTF_FILE  = 1;
TX_FILE = 2;
FILE_FILTERS = ‘TX files (*.TX)|*.TX|Rich Text Format

(*.RTF)|*.RTF’;
UNTITLED = ‘Document’;

Adding the Edit and Format Menu Event Handlers

The event handlers for the Edit and Format menus are:

procedure TForm1.Cut1Click(Sender: TObject);
begin

TextControl1.Clip(CLIP_CUT);
end;

procedure TForm1.Copy1Click(Sender: TObject);
begin

TextControl1.Clip(CLIP_COPY);
end;

procedure TForm1.Paste1Click(Sender: TObject);
begin

TextControl1.Clip(CLIP_PASTE);
end;

procedure TForm1.Character1Click(Sender: TObject);
begin

TextControl1.FontDialog;
end;

procedure TForm1.Paragraph1Click(Sender: TObject);
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begin
TextControl1.ParagraphDialog;

end;

Adding the File Menu Event Handlers

The word processor will be able to process two types of files: TX-
formatted files and RTF files. The following listing shows you how to
declare data members and methods for loading and saving files:

TForm1 = class(TForm)
...
private

FHandle: Integer;
FileType: Integer;

public
procedure CreateTheFile(FileName: String);

procedure SaveTX(FileName: String);
procedure SaveRTF(FileName: String);
procedure LoadTX(FileName: String);
procedure LoadRTF(FileName: String);

end;

The methods are defined as:

procedure TForm1.CreateTheFile(FileName: String);
var
   f: File;
begin

AssignFile(f, FileName);
Rewrite(f);
CloseFile(f);

end;

procedure TForm1.LoadTX(FileName: String);
begin

with TextControl1 do begin
SelStart := 0;
SelLength := -1;
SelText := ‘’;
Load(FileName, 0);

end;
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end;

procedure TForm1.SaveTX(FileName: String);
begin

if not FileExists(FileName) then
CreateTheFile(FileName);

TextControl1.Save(FileName, 0);
end;

procedure TForm1.LoadRTF(FileName: String);
begin

with TextControl1 do begin
SelStart := 0;
SelLength := -1;
SelText := ‘’;
RTFImport(FileName, 0);

end;
end;

procedure TForm1.SaveRTF(FileName: String);
begin

TextControl1.RTFExport(FileName);
end;

Having defined the methods for loading and saving files, you can use
them in the File menu’s event handlers:

procedure TForm1.Open1Click(Sender: TObject);
var

FExt: String;
begin

OpenDialog1.Filter := FILE_FILTERS;
if OpenDialog1.Execute then begin

FExt := UpperCase(ExtractFileExt(OpenDialog1.FileName));
if fExt = ‘.TX’ then begin

LoadTX(OpenDialog1.FileName);
FileType := TX_FILE;

end
else if fExt = ‘.RTF’ then begin

LoadRTF(OpenDialog1.FileName);
FileType := RTF_FILE;

end;
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Caption := OpenDialog1.FileName;
end;

end;

procedure TForm1.Save1Click(Sender: TObject);
begin

if Caption = UNTITLED then begin
SaveAs1Click(Sender)

end else begin
case FileType of

TX_FILE: SaveTX(Caption);
RTF_FILE: SaveRTF(Caption);

end;
end;

end;

procedure TForm1.SaveAs1Click(Sender: TObject);
var

FExt: String;
begin

SaveDialog1.Filter := FILE_FILTERS;
SaveDialog1.DefaultExt := ‘tx’;
if SaveDialog1.Execute then begin

FExt := UpperCase(ExtractFileExt(SaveDialog1.FileName));
if FExt = ‘.TX’ then begin

SaveTX(SaveDialog1.FileName);
FileType := TX_FILE;

end else if FExt = ‘.RTF’ then begin
SaveRTF(SaveDialog1.FileName);
FileType := RTF_FILE;

end;
Caption := SaveDialog1.FileName;

end;
end;
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Using TX Text Control in Visual C++
This chapter discusses how to use TX Text Control in Visual C++ 4.x,
5.x and 6.x. We're assuming that you already have working knowledge
of Visual C++, or at least are familiar with the Visual C++
documentation and online help.

Creating Applications in Visual C++
Creating a Dialog, CFormView, or CView Based OCX Application

1. Start Visual C++.

2. From the File menu, choose New. The New dialog box appears

3. VC 4.x: In the New box, select Project Workspace and click OK.
VC 5.x/6.x: In the New box, select Projects Tab.

4. The New Project Workspace dialog appears.

5. Browse to the desired directory path.

6. In the Name text box, type a name for your project.  This will create
a sub-directory of that name in the current path.

7. From the Type list, select MFC AppWizard(exe) to create a project
based on the MFC library.

8. VC 4.x: Click the Create button.
VC 5.x/6.x: Click the OK button.

The MFC AppWizard - Step 1 Dialog appears.

If you wish to create a Dialog based application, click the Dialog radio
button, click NEXT and procede to the section, Dialog Based
Applications. If you wish to create a CFormView based application,
click the "Single Document" or "Multiple Documents" radio button,
click NEXT and procede to the section, CFormView Based Application.
If you wish to create a CView based application, click the "Single
Document" or "Multiple Documents" radio button, click NEXT and
procede to the section, CView Based Applications.

Dialog Based Applications
1. In the Step 2 dialog, click on the OLE Controls (VC 5.x/6.x:

ActiveX Controls) check box to add built-in support for OCX
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products.

2. Click on NEXT button.
The Step 3 dialog will appear.

3. In the Step 3 dialog, you can accept the default options by clicking
the NEXT button.

4. In Step 4, you can accept the default options by clicking the FINISH
button. VC++ will build your project.
The New Project Information dialog will appear.

5. Click OK

CFormView Based Applications
1. In the Step 2 dialog you can accept the default options by clicking

the NEXT button.

2. In the Step 3 dialog, click on the OLE Controls (VC 5.x/6.x:
ActiveX Controls) check box to add built-in support for OCX
products.

3. Click on Next button.

4. In the Step 4 and 5 dialogs you can accept the default options by
clicking the NEXT button.

5. In the Step 6 dialog, select the class view name from the class list at
the top of the dialog.
CView will appear in the Base Class listbox.

6. In the Base Class listbox, change CView to CFormView.

7. Then click on the FINISH button to have VC++ build your project.

CView Based Applications
1. In the Step 2 dialog you can accept the default options by clicking

the NEXT button.

2. In the Step 3 dialog, click on the OLE Controls (VC 5.x: ActiveX
Controls) check box to add built-in support for OCX products.

3. Click on Next button.

4. In the Step 4 and 5 dialogs you can accept the default options by
clicking the NEXT button.
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5. In the Step 6 dialog, click on the FINISH button to have VC++ build
your project.

Adding the Text Control Component to your Project
To insert a Text Control component into your project:

1. VC 4.x: From the Insert menu, choose Components.
The Component Gallery dialog box appears.
Select the OLE Controls tab.
If the Text Control Text Control icon is not visible in the Gallery,
click Customize to add the control.
Select the control from the Component list on the right and click OK.
This returns you to the Component Gallery.
VC 5.x/6.x: From the Project / Add to Project menu choose
Components and Controls.
Open the Registered ActiveX Controls folder.

2. Select the Text Control icon in the Gallery and click Insert.
The Confirm Classes dialog will display.

3. Click OK to confirm and exit the dialog.

4. Repeat steps 2 and 3 for the Status Bar, Ruler, and Button Bar
controls.

5. Click Close to exit the Component Gallery.

The Text Control and its tools should now appear in the Control palette.

When VC++ adds components to your project, it creates CPP and H
source files defining the class, properties, and methods for the control.
It is a good idea to take a look at these files to understand what they
contain. Methods and properties are not accessed the same in C++ as
they are in many other languages like Visual Basic. When these files are
generated, VC++ creates both a Get and Set function for most methods
and properties.  Text Control, for example, has a Text property.  VC++
will create both a GetText and SetText member functions.

Adding the Component to your Dialog or CFormView:
1. In the Resource Editor, bring up the dialog that you want to place

Text Control into.

2. Click on the Text Control component in the Editor's Control palette.
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3. Draw the component on the dialog box.

4. Now this can be placed and sized as desired using the handles around
the control.

5. Click on the right mouse button to bring up a floating menu.  The
design-time properties for the control can be viewed and modified
through this menu.

Assigning Member Variables
Once you have added the text control to the dialog, it will be necessary
to assign a member variable to each control to gain access to the
methods and properties at runtime.

1. From the View menu, choose ClassWizard.

2. Select the Member Variables tab.

3. Select the control in the Control ID window for which you wish to
add a variable and click the Add Variable button.
The Add Member Variable dialog will display.

4. Type in the member variable name e.g. something like m_txctrl.
Accept the default variable category and type, by clicking OK.

5. The MFC ClassWizard dialog will display the variable you added in
the Control ID window.

6. Repeat steps 3 and 4 for each of the Text Control controls,
specifying a new name for each.

7. Once you have added all the variables, click on OK in the MFC
ClassWizard dialog to return to your project.

Adding the Text Control Component to your CView:
1. In the file list, bring up the header file for the view

(<projname>view.h ).

2. At the top of the file, include each of the Text Control control header
files:

#include "tx4ole.h"
#include "txbbar.h"
#include "txruler.h"



Page 24 Getting Started

#include "txsbar.h"

3. In the Attributes section, as a public member, add the following to
create member variables for each of the controls in your view:

CTX4OLE m_txctrl;
CTXBBAR m_txbbar;
CTXRULER m_txruler;
CTXSBAR m_txsbar;

4. Now through the file list, bring up the C++ source file for the view
(<projname>view.cpp).

5. Start the ClassWizard.  Make sure the view class is selected as the
Class Name.

6. Select the View object in the Object Id listbox.

7. Select the "Create" message in the Messages listbox.
The Create handler will initially come up with the following code:

return CWnd::Create(lpszClassName, lpszWindowName, dwStyle, rect,
pParentWnd, nID, pContext);

Change this to the following:

if (CWnd::Create(lpszClassName, lpszWindowName, dwStyle, rect,
pParentWnd, nID, pContext) == 0)

return 0;

WCHAR szLic[] = L“AB-12345TS-1234567890“;
BSTR bstrKey = SysAllocString(szLic);
BOOL bSuccess = m_txctrl.Create(NULL, dwStyle, rect, this, 1000,

NULL, NULL, bstrKey);
SysFreeString(bstrKey);
if (!bSuccess)

return 0;
if (m_txbbar.Create("TextControl ButtonBar", dwStyle, rect,

this, 1001) == 0)
return 0;

if (m_txruler.Create("TextControl Ruler", dwStyle, rect,
this, 1002) == 0)

return 0;
if (m_txsbar.Create("TextControl StatusBar", dwStyle, rect,
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this, 1003) == 0)
return 0;

return TRUE;

8. Start the ClassWizard. Select view class as the Class Name.

9. Select the View object in the Object Id listbox.

10.Select the "WM_SIZE" message in the Messages listbox.

11.Click on the Add Function button to create the OnSize handler
function for this message.

12.Add the following code to the handler:
if (m_txctrl.m_hWnd && m_txbbar.m_hWnd && m_txruler.m_hWnd &&
m_txsbar.m_hWnd) {

m_txctrl.MoveWindow(0, 60, cx, cy-(25+60));
m_txbbar.MoveWindow(0, 0, cx, 30);
m_txruler.MoveWindow(0, 30, cx, 30);
m_txsbar.MoveWindow(0, cy-25, cx, 25);

}

Licensing the Control
The code added in the previous section, uses a license string to create a
Text Control. Text Control is shipped as a CD version and as a trial
version that can be downloaded and unlocked. The license string for the
CD version users is the Text Control serial number. The license string
for the trial version users is the customer key followed by the serial
number when the trial version is unlocked. When you use the locked
trial version to test Text Control's features, use only your customer key
as license string. In the code example above the customer key is "AB-
12345" and the serial number is "TS-1234567890".

Connecting the Text Control Controls
Connecting the Controls:

1. In the Create handler, add the following code:

m_txctrl.SetButtonBarHandle(m_txbbar.GetHWnd());
m_txctrl.SetRulerHandle(m_txruler.GetHWnd());
m_txctrl.SetStatusBarHandle(m_txsbar.GetHWnd());
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Handling Events in your Dialog or CFormView:
Assigning Message Handlers:

1. Start ClassWizard

2. In the Class Name listbox, select the Dialog or CFormView class
that was created.

3. In the Messages listbox, select the desired message to handle and
click on Add Function button to add a handler for this. For our
example, select the "Click" event and click on the Add Function
button to add the handler for this.

4. Click on the Edit Code button to edit the new function.

5. Add the following code in the function:

MessageBox ("Click Event","You clicked on the document");

6. Run the program and when the document is clicked on, the message
"You click on the document".

Setting Properties in Visual C++
You can easily set specific properties for each of the controls you
include in your project.

To set properties for a control:

1. Double-click on the control in your project that you wish to set
properties for. The Control Properties dialog will display.

2. Select the appropriate tab for the property settings you wish to
modify.
Properties are grouped together in categories, such as paragraphs,
fonts, and pages.

3. Modify the property settings as needed. For more information on
each property, see 'Text Control Properties, Events, and Methods.'

4. Once you have set the properties for the active control, close the
Control Properties dialog to return to your project.

5. Repeat steps 1 through 4 for each control.
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What Comes Next
Now that you’ve created your first TX Text Control project, you can see
how quick and easy it is to add word processing functionality into your
application. Naturally, TX has many more features than these simple
examples demonstrate such as OLE Object support, image embedding,
table support, headers and footers, macro fields, hypertext links, undo/
redo, printing, and zooming. To find out more information about these
features and how to use them, please use the following resources:

Online Manuals

TX Text Control comes with several online manuals that provide
complete information on programming and using TX Text Control. The
OCX Programmer’s Guide describes the OCX interface, including a
complete OCX property, method, and event reference. It also discusses
the various sample programs. The DLL Reference Manual contains info
on how to access Text Control without the OCX wrapper.

Sample Programs

In addition to the reference manuals, Text Control comes with a wealth
of sample programs. These are all stored under the Samples directory,
that is a subdirectory of your selected Text Control installation
directory. Each sample project is located within its own subdirectory.

Readme Files

Before you get too involved with Text Control, you should take a quick
look at the Readme.wri file. It contains the latest and greatest news
concerning Text Control, including new information since the manuals
were printed.

Technical Support

Free technical support for Text Control can be obtained at
http://www.textcontrol.com/support or contact The Imaging Source
Europe GmbH by fax at +49-421-33591-80.
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